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Legal notes 

© 2016 ISD ® Software und Systeme GmbH. All rights reserved. 

This User Guide and the software described herein are provided in conjunction with a license and may only be used or copied in 
accordance with the terms of the license. The contents of this User Guide solely serve the purpose of information; it may be 
modified without prior notice and may not be regarded as binding for the ISD Software und Systeme GmbH. The ISD Software und 
Systeme GmbH does not assume any responsibility for the correctness or accuracy of the information provided in this document. No 
part of this document may be reproduced, saved to databases or transferred in any other form without prior written permission by 
the ISD Software und Systeme GmbH, unless expressly allowed by virtue of the license agreement.  

All mentioned products are trademarks or registered trademarks of their respective manufacturers and producers. 

 

The license management portion of this Licensee Application is based upon one or more of the following copyrights: 

Sentinel®RMS 
© 1989-2016 SafeNet, Inc.  
All rights reserved. 

 

Sentinel®EMS™ 
© 2008-2016 SafeNet, Inc.  
All rights reserved. 

 

Sentinel® is a registered trademark of SafeNet, Inc.  

 

Autofac, Copyright (c) 2016 Autofac Project 

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the 
"Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, 
distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject 
to the following conditions: The above copyright notice and this permission notice shall be included in all copies or substantial 
portions of the Software. 

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT 
LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN 
NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, 
WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE 
SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE. 

 

Castle.Core, Copyright 2004-2016 Castle Project 

Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in compliance with the License. 
You may obtain a copy of the License at http://www.apache.org/licenses/LICENSE-2.0 Unless required by applicable law or agreed to 
in writing, software distributed under the License is distributed on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF 
ANY KIND, either express or implied. See the License for the specific language governing permissions and limitations under the 
License. 

 

Apache log4net, Copyright 2004-2016 The Apache Software Foundation 

This product includes software developed at The Apache Software Foundation (http://www.apache.org/). Licensed under the Apache 
License, Version 2.0 (the "License"); you may not use this file except in compliance with the License. You may obtain a copy of the 
License at http://www.apache.org/licenses/LICENSE-2.0 Unless required by applicable law or agreed to in writing, software 
distributed under the License is distributed on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either 
express or implied. See the License for the specific language governing permissions and limitations under the License. 

 

NHibernate, Copyright (c) The NHibernate Project 

This library is free software; you can redistribute it and/or modify it under the terms of the GNU Lesser General Public License as 
published by the Free Software Foundation (version 2.1). This library is distributed in the hope that it will be useful, but WITHOUT 
ANY WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the 
GNU Lesser General Public License for more details. You should have received a copy of the GNU Lesser General Public License 
along with this library; if not, write to the Free Software Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 
USA 

 

http://www.apache.org/licenses/LICENSE-2.0
http://www.apache.org/
http://www.apache.org/licenses/LICENSE-2.0
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Fluent NHibernate, Copyright (c) 2008-20012, James Gregory and contributors 

All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the 
following conditions are met: 

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. 

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the 
documentation and/or other materials provided with the distribution. 

* Neither the name of James Gregory nor the names of its contributors may be used to endorse or promote products derived from 
this software without specific prior written permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR 
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED 
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.  
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1 Important Installation Information 
Please note: 

We recommend deactivating local licenses and network licenses before performing an update/upgrade of 
the operating system (e.g. from Windows 8 to Windows 10), and activating them again after successful 
update/upgrade of the operating system. 

 

1.1 Hardware Requirements for HELiOS 
For the installation of HELiOS you may use any hardware possessing current drivers for the operating 
systems used. Please note, for instance, that the graphics card drivers need to support the complete 
OpenGL instruction set.   

 

Hardware requirements (minimum) 

Processor (CPU): Pentium 4 compatible processor with SSE2 support 

RAM: 1 GB RAM 

Graphics card: Fully OpenGL capable graphics card with at least 128 MB memory (if the 
error message Set Pixel Format failed is displayed during program start, the 
OpenGL driver does not support the entire instruction set). You can use the 
OpenGLCapabilityTester to check whether the OpenGL capabilities of your 
computer are sufficient. This tool is available for download in the ISD Wiki 
at FAQ > System Requirements > HiCAD. 

Operating system: see Compatibility Matrix  

Database systems: see Compatibility Matrix  

 

Recommended hardware for simultaneous HiCAD operation 

Computer: Fujitsu CELSIUS M740 

Processor (CPU): Intel® Xeon® Processor E5-1630 v4 (4 Cores, 3.70 GHz, 10M Cache) 

RAM: 2 x 8 GB, DDR4, 2.133 MHz, rg ECC 

Hard disk: 1 x 512 GB, SSD SATA III Premium bay, 2,5 inch 

Graphics card: NVIDIA Quadro K2200 (4 GB) 

Screen resolution Full HD (1920x1080) 

Operating system: Microsoft Windows 8.1 (64 Bit)  

Database systems: see Compatibility Matrix 

 

» Microsoft .NET Framework and Visual C++ Runtime Libraries need to be installed on the computer 
before HELiOS can be used; these packages are installed by the HELiOS installer if necessary. 

» To be able to work with HELiOS, a database system must be available and prepared for HELiOS. For this 
you require 

 a Microsoft SQL database management system on your server, 

 a HELiOS database imported with the HELiOS Database Creator and  

 an ODBC connection on the clients.  

http://www.hicad.isdgroup.de/cms/dofiles/f_2402_865111e944a215c345d37ddd03418326_0_openglcapabilitytesterpzip.zip
https://wiki.isdgroup.com/download/attachments/32374804/OpenGLCapabilityTester.exe
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Documents (in .pdf format) for the installation of the database system and the import and export of the 
database can be found in the Wiki at Product Know-how > Documentation > HELiOS.  

» Current information on system requirements can also be found on the Internet at www.isdgroup.com > 
Support > ISD Wiki > Product know-how > FAQ. 
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1.2 System Requirements for HELiOS Database 
As of HELiOS 2016 SP 2 you can use the following Server types as Database Servers (RDBMS): 

» Microsoft SQL Server, Versions 2008 - 2016 

» Oracle Database Server, Versions 11g R1 - 12c. 

The requirements with regard to the hardware primarily depend on the specifications given by the respective 
RDBMS supplier (Microsoft / Oracle). 

 

The following recommendations are meant to serve as a rough guideline: 

 

Operating 
system 

Microsoft Windows Server Version 2008 (64 Bit) or higher 

Processor Intel Pentium IV, Intel Xeon, AMD Opteron, AMD Athlon 64 

RAM At least 4 GB (with an increasing database size the RAM should also be increased to 
ensure optimum performance) 

Mass storage 
device 

Mass storage device: 10 GB available hard disk space (absolute minimum; the actual 
demand depends on the database size) 

Graphics Standard, SVGA or higher 

 

 Please note: 

 Virtual Servers are generally supported; it is important, though, that all requirements of the RDBMS 
suppliers are strictly observed. For performance reasons we recommend using native computers. 

 For safety reasons domain controllers should not be used simultaneously as Database Servers or other 
Servers. 

 The HELiOS Database Server, the HELiOS Vault Server and the ISD License Server can be installed and 
run simultaneously on one computer.  

 For safety reasons the HELiOS Plot Spooler should not be run together with a HELiOS Database Server or 
a Vault Server on one computer.  

 

 



Important Installation Information 

 11 

1.3 Hardware Requirements License Server 
 

Processor (CPU): x86 Processor for 32-Bit / x86-64 Processor for 64-Bit 

Recommended: 2 GHz Processor 

RAM: Minimum: 1 GB  

Recommended: 2 GB (with SQL Server: > 3 GB ) 

Hard disk: 1.2 GB free disk space 

Operating System (Server) Windows 10 

Windows 8 

Windows 7 (32 & 64-Bit) 

Windows Server 2016 

Windows Server 2012 

Windows Server 2008 (32 & 64Bit) 

Windows Server 2008 R2 (32 & 64Bit) 

IP/MAC Address A static IP address is required for an error-free operation of the license 
server. 

For virtual servers a static MAC address needs to be available. 

 

 Important:  

 From HELiOS 2012 (Version 1700) onwards, the installation of a license server and another ISD product 
on the same computer is outside of warranty! The ISD strongly advises against using such 
constellations.  

 A static IP address is mandatory for a proper functioning of the license server.   

 A license server program needs not necessarily run on a fileserver system or on a special hardware 
server; suitable will be any computer fulfilling the above-mentioned requirements. 
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1.4 Hardware Requirements Vault Server 
 

Processor (CPU): Pentium III-compatible processor, Minimum: 1 GHz 

RAM: Minimum: 1 GB, Recommended: 4 GB or more 

Graphics Card: VGA (no special requirements) 

Hard disk: For software: 100 MB free disk space 

For user data: Depending on the amount of data to be expected, plus backup 
memory of >= 100%  

(distribution over several volumes/drives possible, redundant array of 
independent disks (RAID) for primary user data recommended) 

Operating system 
(virtual servers also 
possible): 

 

Windows 10 

Windows 7 Professional 
Windows 7 x64 Professional 

Windows 8 Professional 
Windows 8 x64 Professional 

Windows Server 2008 SP2 
Windows Server 2008 SP2 x64  

Windows Server 2008 R2 x64 

Windows Server 2012 
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1.5  Hardware requirements SmartSearch 
See 1.3 Hardware Requirements Vault Server 
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1.6 System Requirements HELiOS Internet Server 
For the HELiOS Internet Server the same system and hardware requirements as for the HELiOS Desktop 
apply.  

In addition, however, the installation of the Microsoft Internet Information Services (IIS) is required:  

» Microsoft Internet Information Services, at least Version 7, with CGI support. This is included as of 
Windows Server 2008/Windows 7, but requires a separate installation that needs to be performed 
before installing the HELiOS Internet Server!! 

Proceed as follows (Example based on Windows 7): 
Choose Control Panel > Programs and Features and, at the top left of the window, select Turn 
Windows features on or off. In the Windows Features dialogue window, choose Internet Information 
Services > Web Management Tools, and Internet Information Services > World Wide Web Services > 
Application Development Features and activate the checkboxes as shown below: 

 

» Furthermore, you require an installed HELiOS version. 

 

  Please note: 
 The HELiOS Desktop on the same system must be running permanently, i.e. the login session must 

not be ended! 

 A “Default Web Site” with Port 80 may already have been installed in the IIS Manager. In this case 
the HELiOS Internet Server (for which Port 80 has also been preset) cannot be executed properly. It 
is therefore recommended to remove this Default Web Site here (Control Panel > Administrative 
Tools > Internet Information Services (IIS) Manager. In the tree structure on the left hand side, 
right-click Default Web Site).  
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If a required website is already using Port 80, you need to select a different Port for the HELiOS 
Internet Server. 

 

 

. 
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1.7 Hardware Requirements HELiOS Spooler 
 

Important installation note! 

As the HELiOS Spooler (as of2015, Version 2000.0) is an entirely new software, an update of the old Spooler 
is not possible. Before installing the new HELiOS Spooler, please make a record of the old Spooler’s settings, 
uninstall it, and then adjust the settings of the new Spooler accordingly. 

Further information can be found in the HELiOS Online Help. 

 

The system requirements for the Spooler are analogous to those of your CAD system. The RAM should be at 
least as large as those of the utilized CAD systems. The reason for this is that the Spooler may, besides its 
automation as a Plot Server, also be used for other tasks, such as conversion of HiCAD drawings (e.g. to 3D-
PDF if HiCAD is the CAD system).  

Besides the Client operating systems Windows 7, 8 and 10, the Server operating systems Windows Server 
2008 or Windows Server 2012 can be used. Whether a Server operating system is to be used depends on 
the license conditions for the utilized Microsoft operating system. Here, the number of allowed, 
simultaneous device connections is decisive. 

Windows 7 and 8 allow 20 simultaneous accesses. This is enough for 20 Print Clients provided that all of 
them had actually been started. Please note however that each connection from a non-workstation will 
reduce this number accordingly. 

 

 From HELiOS 2015 (Version 2000.1) onwards, the HELiOS Spooler will only be available as 64Bit version. 
Please note that the Spooler will then only support 64Bit applications.  

 

Recommended hardware for HELiOS Spooler in conjunction with HiCAD 

Computer: Fujitsu CELSIUS M740 

Processor (CPU): Intel® Xeon® Processor E5-1630 v4 (4 Cores, 3.70 GHz, 10M Cache) 

RAM: 2 x 8 GB, DDR4, 2.133 MHz, rg ECC 

Hard disk: 1 x 512 GB, SSD SATA III Premium bay, 2,5 inch 

Graphics card: NVIDIA Quadro K2200 (4 GB) 

Screen resolution: Full HD (1920x1080) 

Operating system: Microsoft Windows 8.1 (64Bit)  

Database system: See Compatibility Matrix  
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1.8 Compatibility Matrix 
 

 HELiOS 

 2016 2015 2014 2013 

Windows XP     

Windows Vista     

Windows 7     

Windows 8 / 8.1     

Windows 10     

      

Microsoft SQL Server 2000     

Microsoft SQL Server 2005     

Microsoft SQL Server 2008     

Microsoft SQL Server 2012     

Microsoft SQL Server 2014     

Microsoft SQL Server 2016  (as of SP2, 
on request also 

for SP1) 
   

Oracle Database Server 10g     

Oracle Database Server 11g R1     

Oracle Database Server 11g R2     

Oracle Database Server 12c     

      

HiCAD 2011     

HiCAD 2012     

HiCAD 2013     

HiCAD 2014     

HiCAD 2015     

HiCAD 2016     
     

AutoCAD 2011     

AutoCAD 2012     

AutoCAD 2013     

AutoCAD 2014     (as of SP2) 

AutoCAD 2015   (as of SP2)   

AutoCAD 2016   (as of SP2)   

AutoCAD 2017  (as of SP2)    
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 HELiOS 

 2016 2015 2014 2013 

Inventor 2008     

Inventor 2009     

Inventor 2010     

Inventor 2011     

Inventor 2012     

Inventor 2013     

Inventor 2014     (as of SP2) 

Inventor 2015    (as of SP2)  

Inventor 2016   (as of SP2)   

Inventor 2017  (as of SP2)    

      

Solidworks 2008     

Solidworks 2009     

Solidworks 2010     

Solidworks 2011     

Solidworks 2012     

Solidworks 2013     

Solidworks 2014     (as of SP2) 

Solidworks 2015    (as of SP3)  

Solidworks 2016     

CAE-SYSTEM     

EPLAN Electric P8 Version 2.4  (as of SP1)    

OFFICE     

Office 2003     

Office 2007     

Office 2010     

Office 2013     

Office 2016     
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2 Installation 
The DVD contains the installation files for:  

» HELiOS  

» Online Help 

» Vault Server 

» License Server 

» HELiOS Plot Management (Server Component Spooler) 

» HELiOS Internet Server 

» The HELiOS Database creator (to set up the HELiOS database for the very first time and import/export 
an existing database) 

The HELiOS DVD has been developed for a use on Windows operating systems. When you insert the DVD, 
an installation wizard will be started automatically.    

 

 The HELiOS version needs to be installed on the hard disk of the computer; it is not possible to start the 
program from the DVD. 
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2.1 Installing HELiOS 
To install HELiOS, start Windows. If Windows is already open, close all other applications. Insert the HELiOS 
DVD in your DVD drive. The installation wizard will be started automatically. Follow the instructions on the 
screen. 

 

Click the HELiOS button to start the installation of the HELiOS Desktop.  

Microsoft .NET Framework and Visual C++ Runtime Libraries need to be installed on the computer before 
HELiOS can be used; these packages will be installed now if required.  
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Select an installation directory.  

In accordance with the current Microsoft guidelines, the HELiOS documents will be stored at 
C:\Users\Public\Documents\ISD Software und Systeme\ after a new installation of the HELiOS Desktop. Only 
the Administrator has write permissions for the installation directory (..\ProgramFiles\..). 

If you are working with the HELiOS Vault Server you can keep this diretory. Otherwise, the path needs to be 
changed after installation and should then refer to a directory for which all users have read and write 
permission. Typically, this is a path to a shared directory on the network. 

 

Please read the Notes on Hardware Exchange carefully.  

Notes on Hardware Exchange 

If you use local HiCAD/HELiOS/HELiCON licenses and want to exchange any hardware components, modify 
the partitioning of, or re-install the operating system, you need to revoke the existing license on the 
workstation first, and request, using the new hardware or modified configuration, a new license key (further 
information on the procedure can be found in the software documentation). 

If a revocation is technically possible, but will not be performed, the ISD reserves the right to charge costs in 
an appropriate amount for the reissuing of the license. If the license will not be revoked, or if such 
revocation is no longer technically possible, the ISD may request proof that the unrevoked license is no 
longer utilisable; in case of failure to produce such proof, the ISD reserves the right to refuse the transfer of 
the license to a new hardware. 
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Accept the notes to continue with the installation. 

 

You can now start with the installation or modify the Extended Settings, e.g. for HELiOS. 

 

In case of a new installation you can specify an arbitrary name for the system data source. In case of an 
update, the existing data source will be offered. User and Password will be identical with the ODBC login.  

If you use a Vault Server, activate the Vault Client checkbox. Enter the name of the Server in the Address 
input field, and the Server Port of the Vault Server in the Port input field. You already entered both during 
the installation of the Vault Server.  

If you want to process your print jobs via the ISD Plot Management, you need to install one PrintClient on 
each workstation.  

In the Server field, enter the network name of the computer on which the HELiOS Spooler is installed. The 
Spooler collects the print jobs and processes them according to your settings. 
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The availability of interfaces with HELiOS depends on the programs that are installed on your computer. You 
can only link 32Bit versions to HELiOS 32Bit versions, and only link 64Bit versions to HELiOS 64Bit versions. 
An exception is the MS Office Interface, where you can link a 32 Bit Office to a 64 Bit HELiOS. Please note 
however that an additional, special ODBC connection will be required for old BOMs. In such cases, please 
contact the ISD Consulting team.  

Multiple selections of HELiOS Interfaces are also possible. The HELiOS functions will be integrated in the 
programs that are linked to HELiOS. 

Please take a look at the Compatibility Matrix in Chapter 1.7. to check which interfaces to external software 
products are supported by HELiOS 2016.  

When installing the CAD interface (AutoCAD, Inventor or SolidWorks) the specific CAD configuration will be 
considered. The only thing you need to do is to copy the drawing frame template files from the 
corresponding ...\templates\ subdirectory.   

The installation automatically executes the configuration file MultiCAD.csv with the HeliosClientConfig.exe 
tool. If you work with your own .csv file, you can execute it subsequently: Start the HeliosClientConfig.exe 
tool from the \exe\ directory of your HELiOS installation, click the ... button to select the path of the file and 
confirm with OK. 

 

 Please note: 

 The corresponding foreign software needs to be installed on the same system.  

 When creating an interface between HELiOS and one of these systems, please make sure that the Bit 
versions of HELiOS and the external software are identical. Interfaces between a 32Bit and a 64Bit 
Version are not possible. 

 For EPLAN you also require the Article Synchronization Service running separately on the system.  You 
will find the corresponding button in the HELiOS installation mask.  For the configuration of the HELiOS-
EPLAN interface please contact the ISD Consulting team.  

 

Interfaces with foreign systems can also be added via the Windows Control Panel. Select Start > Control 
Panel > Programs and Features, activate HELiOS, then right-click and select Change. This starts the 
installation of HELiOS, enabling you to select further interfaces with foreign software products on the HELiOS 
Interfaces tab.  

Further information, e.g. how to activate specific interfaces in the foreign software, can be found in the 
Online Help for HELiOS.  
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You need the License Administration Tools for the installation of server licenses.  

Click Save to save the Extended Settings to an INI file. If you place the INI file in the installation directory 
when installing server licenses, the settings will be applied.  

Close the Extended Settings dialogue with OK and click Install. 

 

 

After successful installation, you will find the link to the HELiOS Desktop on the desktop for program launch.   
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2.2 Installing the Online Help  
The Online Help is available locally (status of the date of installation DVD creation) and on the Internet 
(regularly updated) at help.isdgroup.com. Both versions of the Help can be directly started from HELiOS. 
Please note that corresponding login data are required to access the Internet version of the Help.   

Start Windows to install the Help. If Windows is already open, close all other applications. Insert the DVD in 
the drive, which automatically starts the installation wizard.  

 

Click the HELiOS Help button. 

 

http://www.help.isdgroup.com/
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Specify the installation directory for HELiOS. 

 

Click Install.  

 

After successful installation, the Help can be found in the program folder and can be called via HELiOS. 
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2.3 Installing the Vault Server 
Start Windows to install the Vault Server. If Windows is already open, close all other applications. Insert the 
DVD in the DVD drive, which automatically starts the installation wizard.  

 

Click the Vault Server button. 
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Specify the installation directory of the Vault Server. 

 

Give the Vault Server a name, e.g. the name of your company, plus the location of your company. This name 
will be shown, for example, when you connect to the Vault Server from the Vault Client.  

 

The Vault Server renames all documents that are managed in the database (e.g. SZA, DOC, XLS, …) to 
*.VDF. These VDF files are saved to the Document directory.  

The files stored in the Management directory contain the assignments of the VDF file names to the “original 
file names”.   

Log files (*.LOG) are saved to the Log directory. They record each access to the VDF files. 

Enter the name of the log file in the Log file name field. The name of the Vault Server would also be possible 
here. If the log file exceeds a certain length, it will be cut down and suffixed by the current date.  
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Click Install. 

 

Click Finish to complete the installation of the Vault Server. You can now install further components offered 
in the selection mask if desired. 
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2.4 Installing the HELiOS Internet Server 
For the HELiOS Internet Server you require the Microsoft Internet Information Services, Services, at least 
Version 7, with CGI support. This is included as of Windows Server 2008/Windows 7, but requires a 
separate installation that needs to be performed before installing the HELiOS Internet Server (see Chapter 
1.5)! 

 

Start Windows to install the HELiOS Internet Server, first start Windows. If Windows is already open, close all 
other applications. Insert the DVD in the DVD drive, which automatically starts the installation wizard.  

 

Click the HELiOS Internet Server button. 
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Specify the installation directory for the software. 

 

Enter the Port number. Default value is 80. If you want the HELiOS Internet Server to run on a different Port 
(because Port 80 is already being used for a different website or application), enter this Port here and click 
Next.  

 

Click Install. 

After successful installation the HELiOS Internet Server will be located in the program folder. 
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2.5 Installing the HELiOS Database Creator 
The HELiOS PDM modules (Document Management, Project and Order Management, Workflow etc.) are 
based on a relational database. Before you put HELiOS into operation, the Microsoft SQL Server database 
administration system needs to be installed on the server, a HELiOS database needs to be imported and a 
ODBC connection needs to be set up on the clients.  

When you set up a HELiOS database for the first time, the HELiOS Database Creator needs to be installed 
and executed on the database server first. The database and table structures will then be created, and filled 
with data records of the HELiOS standard database. 

 

 All information about the correct procedure for the execution of the HELiOS Database Creator, as well as 
the previous and subsequent steps required for the setting up of a database server can be found in the user 
guide for the installation of the Microsoft SQL Server. You can find this document in the ISD Wiki at Product 
Know-how > Documentation > HELiOS. 

 

To install the HELiOS Database Creator, click the corresponding button in the selection mask. The start 
mask of the setup wizard will be displayed.  

 

Click the HELiOS Database Creator button. 
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Click Next to start the installation. 

 

 

Specify an installation directory for the HELiOS Database Creator, and click Next.  

 

Click Install to start the installation.  
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Click Finish to complete the installation of the HELiOS Database Creator. If desired, you can now install 
further components via the selection mask. 

 

 Extensive information on the installation of the SQL Servers, the operation of the HELiOS Database Creator 
tool and the setting up of the ODBC connection on the clients can be found in the Wiki at Product Know-how > 
Documentation > HELiOS. 
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2.6 Installing the HELiOS Spooler 
 

Important installation note! 

As the HELiOS Spooler (as of2015, Version 2000.0) is an entirely new software, an update of the old Spooler 
is not possible. Before installing the new HELiOS Spooler, please make a record of the old Spooler’s settings, 
uninstall it, and then adjust the settings of the new Spooler accordingly. 

Further information can be found in the HELiOS Online Help. 

The HELiOS Spooler is only available as 64Bit version and only supports 64Bit applications.   

 

To install the HELiOS Spooler, please start Windows. If Windows has already been started, please close all 
other applications. Insert the DVD in your DVD drive. The selection mask for various software components 
will then be displayed. Leave this mask open, and install, one after the other, the required software 
components.  

 

 

Click the HELiOS Spooler button.  
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Specify the installation directory for the software. 

 

The Spooler start is in part performed by the system as a background process (Windows Service). For safety 
reasons it is recommended to create a Windows User account, with User name and Password with read 
and access permission, before installation.  

If you do not know the user yet, the Spooler will run, without access to any printers, as a simple Windows 
system service. Now, select Control Panel > Administrative Tools > Services. Right-click the HELiOS 
Spooler and select Properties. On the Log On tab, switch to This account and enter the user name and the 
password (Caution: Should the password of the Spooler user change or expire one day, the authentication 
needs to be renewed accordingly in the Services list. If the Start service upon installation option is active, 
the Spooler service will not require a manual start after installation.   

Normally, the HELiOS Spooler runs as a Windows Service in the background. In this standard configuration 
the Spooler process will be started by the operating system in a special session which is not visible for the 
user. Therefore, the process will even continue running after the Spooler user has logged off from the 
computer.  Unfortunately, internal tests have found that problems may occur with this type of operation in 
conjunction with some CAD systems; currently this applies in particular to the interface with SolidWorks.  

If you are considering using the HELiOS Spooler together with SolidWorks, we therefore recommend 
choosing the “Interactive start” option during installation in order to avoid problems. When this option has 
been selected, the Spooler will no longer be set up as a service, but will be started directly in the foreground 
via the Administration UI. During this type of operation, the Spooler process will appear in the form of a 
small text window in the window bar (Caution: When you log off from the Server, the Spooler process will 
also be ended here!) 

To automatically start the Spooler in the “interactive” configuration, the Helios.Spooler.exe file needs to be 
called from the installation directory with the option “--no-service” – either from the “Autostart” folder of the 
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Spooler user, or via the Windows Task Scheduler. If you have any questions, please contact the ISD 
Consulting team.  

Select the data directory. Activate the Create network share checkbox to enable the communication with the 
PrintClient. If the network share is not created during installation, it must be created manually afterwards. 
Since special settings will be required here, we recommend contacting the ISD Consulting team.  

Choose the CAD system that you want to link to the HELiOS Spooler, and click Next.   

 

You can now begin with the installation. 
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After successful installation the HELiOS Spooler will be located in the folder for programs.  

 

2.7 Installation of the EPLAN Article Synchronization 
In addition to the EPLAN interface that must be activated in the HELiOS Interfaces tab of the Extended 
settings window, you need to install the Article Synchronization service. You can find the corresponding 
button at the bottom right of the selection mask.   

  For the configuration of the HELiOS-EPLAN interface please contact the ISD Consulting team. 

To install the HELiOS Spooler, please start Windows. If Windows has already been started, please close all 
other applications. Insert the DVD in your DVD drive. The installation wizard will then be started 
automatically.  

 

Click the Eplan Article Synchronization button. 
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Specify the installation directory for the software.  

 

Replace LocalSystem with the User login for HELiOS, or a user account with access to HELiOS.  

 

You can now begin with the installation or modify the Extended settings, e.g. for HELiOS.  
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The existing system data source will be suggested. User and Password are identical to those for the ODBC 
login. If you use a Vault Server, activate the Vault Client checkbox. Enter the name of the Server in the 
Address input field, and the Server Port of the Vault Server in the Port input field. These can be found at 

 > HELiOS Options > Database > General > Vault Server .  

Click Save to store the Extended settings in an ini file. Confirm with OK.  

 

Click Install to start the installation. 

 

After successful installation, the EPLAN menu will contain the Synchronize articles with HELiOS function in 
the PDM menu.  
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2.8 Parameter Configuration 
HELiOS provides appropriately adjusted user interfaces and configurations for various interfaces. During 
installation of HELiOS the MultiCAD.csv  file, that sets up the templates required for the operation of the 
interface, will automatically be run via the HeliosClientConfig.exe program.  

You can also load an own *.csv file subsequently if desired. In the EXE directory of your HELiOS installation, 

start the HeliosClientConfig.exe program. Click the  icon and select the *.csv file. Confirm with OK. 

 

Furthermore, HELiOS offers template files for title blocks (AutoCAD drawing frames with database attributes) 
and HELiOS masks that have been adjusted for MultiCAD operation: 

» In the …\templates directory of your HELiOS Desktop installation you will find the adjusted HELiOS 
masks for MultiCAD operation in the …\MultiCAD folder. Copy them to the …\sys directory of your 
HELiOS installation. 

» In the…\templates\AutoCAD\ directory you will find drawing frame templates that you can copy to the 
corresponding templates directory of your CAD software.   
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3 Procedure for Silent Installations 
The silent installation can, for example, be configured for HELiOS Standalone or for the Spooler. The 
procedure is always the same. 

 

3.1 Installation Settings 
To configure the installation options, start the installation setup.exe as usual and make the required settings. 

In the last dialogue of the installation, click on Extended Settings. 

 

Here you can configure in particular the settings for the User Configuration in such a way that user 
interactions will no longer be required. 
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Clicking Save creates a setup.ini file containing the desired settings. This file will be loaded automatically if it 
is located in the same directory as the Windows Installer package HELiOS.msi. Alternatively you can specify 
a file via the command line:  

setup.exe  SETTINGS="<Ini-Datei>" /l*v "<Log-Datei>" 

or 

msiexec  /i  HELiOS.msi SETTINGS="<Ini-Datei>" /l*v "<Log-Datei>" 

In this case the starting will not be “silent”, i.e. the installation dialogues will appear, but with the default 
values of the .ini file. 

The option /l*v "<Log-Datei>" creates a log file of the installation which can be used for the diagnosis of 
installation problems.  

 

3.1.1 Redistributables 
Before distributing the installation you need to install the required redistributables on the target systems in 
order to circumvent the Microsoft-EULAs.  

Examples:  

vcredist.exe /passive 

dotNetFx40_Full_x86_x64.exe /passive 

The respective command line options of the individual Redistributable Installer can be called via the 
command line option /?.  

If required, the .msu files of the Windows Installer 4.5 can be installed with the Windows Package Manager 
pkgmgr.exe (http://support.microsoft.com/kb/934307/de). 

The packages can be installed with /passive /norestart. Otherwise, a reboot would be initiated automatically. 
If a package requires a reboot, the return value is 3010; otherwise it is 0 or an error code.  

 

 You need to install the redistributables that are located on the DVD at Program32 or Program64 (except 
for the setup.exe and the language-specific folders such as de-de). 

The situation for HELiOS is slightly different. Here, the installation packages can be found in the folder 
Helios\heldsk64\ (for a HELiOS Desktop Standalone installation) or Helios\M-Versions\20??\ , with ?? standing for 
the concrete year date of the HiCAD Version to be matched with an updated HELiOS. 

http://support.microsoft.com/kb/934307/de
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The utilisation of the msi package or the setup.exe, respectively, differs insofar as the setup.exe will issue an 
interactive message if a requirement (redistributable) is missing, while the msi package will cancel the process 
with an error code. The latter might be more suitable for a deployment within the scope of a software 
distribution programme. 

 

3.1.2 Starting the Installation in the Silent Mode 
The installation can only be set to the silent mode via the command line: 

setup.exe  SETTINGS="<Ini-Datei>" /passive /l*v "<Log-Datei>" 

or 

msiexec.exe  /i HELiOS.msi /qb!- /SETTINGS="<Ini-Datei>" /l*v "<Log-Datei>" 

As neither dialogues nor error messages are displayed, /l*v "<Log-Datei>" creates a log file of the installation 
which can be used for the diagnosis of installation problems. 

Information on further command line options can be obtained via the command line, by means of the 
command msiexec /? , and via the Internet at 

http://technet.microsoft.com/de-de/library/ cc759262%28WS.10%29.aspx#BKMK_SetUI 

http://msdn.microsoft.com/en-us/library/windows/desktop/ aa372024%28v=vs.85%29.aspx 

 

3.1.3 Example of a Batch Installation incl. Redistributables and Log 
@set SOURCE=\\entw042\Setups\HELiOS 2000 

 

"%SOURCE%\vcredist_x86_10.0.40219\vcredist_x86.exe" /passive /norestart 

@if errorlevel 1 echo Fehler bei Visual C++ Runtime Installation && goto error 

"%SOURCE%\DotNetFX40\dotNetFx40_Full_x86_x64.exe" /passive /norestart 

@if errorlevel 1 echo Fehler bei .NET Installation && goto error 

 

msiexec.exe /qb!- /i "%SOURCE%\de-de\HELiOS.msi" /l*v 
"%SOURCE%\logs\%COMPUTERNAME%_HELiOSInstallLog.txt" SETTINGS="%SOURCE%\Config\setup.ini" 

@if errorlevel 1 echo Fehler bei HELiOS Installation && goto error 

@exit 

 

:error 

@echo Installationsfehler %errorlevel% 

@net helpmsg %errorlevel% 

@pause 

http://technet.microsoft.com/de-de/library/%20cc759262%28WS.10%29.aspx#BKMK_SetUI
http://msdn.microsoft.com/en-us/library/windows/desktop/%20aa372024%28v=vs.85%29.aspx
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4 Important Notes on Updates 
When performing a HELiOS update, the update start mask shows you the HELiOS subversion, which needs 
to match the existing database. If this is not the case, only an error message will appear when you start 
HELiOS. To update the database schema, use the program HeliosDbUpdate.exe. Please note the following: 

 

Important 

When performing a HELiOS update, an update of the database schema might be necessary as well. If the 
database schema requires an update, you can no longer access the database with older HELiOS versions. 
Therefore, all workstations accessing the database need to be readjusted accordingly at the same time.. 

It is mandatory to make a database backup before the update, as the update can normally only be reverted 
by importing the backup. 

The responsible administrator should always be informed prior to the update, in order to enable a 
coordinated conversion. 

Updates to HELiOS Version 2016 are only possible from Version 2014 or 2015.   

 

4.1 Updating the HELiOS Database 
Improvements of the HELiOS functionality require a regular updating of the database; if the database version 
is no longer up to date, HELiOS displays the following message (version numbers may vary) when it is 
launched: 

 

To update the database schema, use the program HeliosDbUpdate.exe. Please note the following: 

 

4.1.1 Important Hints before Update  

» It is mandatory to make a database backup before the update, as the update can normally only be 
reverted by importing the backup. 

» After an update, access is only possible with the appropriate HELiOS version. A mixed operation with 
HELiOS versions requiring an older database schema is not possible. 

» The update must be performed once and applies to all HELiOS installations. 

» The responsible administrator should always be informed prior to the update, in order to enable a 
coordinated conversion. 
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4.1.2 Perform Update  
The update can be performed from any HELiOS workstation with a database connection. 

The HeliosDbUpdate.exe program is used for this purpose. It can be started via the Windows Explorer, or 
similar programs, from the exe directory of the HELiOS installation. 

The following mask (software and database version may vary) will be displayed after starting the program: 

 

Click the Update database… button to start the update.  

The following message (version numbers may vary) will be displayed after clicking the button: 

 

If you confirm this message with OK, another confirmation prompt is displayed: 

 

Confirm with Yes to perform the update. After a successful update, the following message will be displayed: 
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A further check can be carried out by clicking the Re-determine button in the main window of the program, 
after confirming this message with OK. 

After a successful update, software version and database version need to be identical. 

 

4.1.3 Lower Database Version Required 
If you use HiCAD and HELiOS together it may occur after an update of HiCAD that according to the error 
message for verification of your database version (see Chapter 4.1) the number of the required sub-version 
is lower than that of the current one, which is, according to the message, not supported. 

In this case a new installation of HELiOS, or an update installation of HELiOS from an appropriate source 
(i.e. via the HELiOS installation DVD, not via the HiCAD installation!) must be performed.    
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4.2 Material Manager (HiCAD) 
For the HELiOS-HiCAD Interface the HiCAD Material Manager (materialmanager.exe) that enables a taking 
over of materials from Catalogue Editor to HELiOS must have the same database schema as HELiOS. 
Therefore the Material Manager will also be updated.  
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4.3 Licensing for Updates 
The HELiOS Version can be obtained either on an installation medium (DVD), or via download from the ISD 
Homepage.  

The activation takes place via a software license. The activation is no longer linked to a dongle, but directly 
to the hardware of a server or an individual workstation. 

If you use a Server License, you need to update the License Server Software and the License Management 
Tools; if you use Local Licenses, you need to install the new version.  

Normally, licenses for older HELiOS versions must be revoked first.  

After confirmation of the revocation you will receive one or several Entitlement IDs enabling you, in 
combination with your E-Mail address and your Password, to activate the new licenses (see 5.3). 

Licenses can be deactivated at any time, without having to contact the ISD Group, via the License Activator 
in the License Manager, i.e. they can be temporarily stored on the Server of the ISD. For this you require 
your Entitlement ID, your E-mail address and your Password. The activation can then be performed on any 
other computer, i.e. the licenses can be transferred to this computer. For Server Licenses this procedure 
can only be performed for the entire license pool.  

 After updating HELiOS (from Version 2008 or older) to a HELiOS Version, you must return your workstation 
dongle to the ISD. You can then no longer use any older HELiOS versions. 
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4.4  Perform HELiOS Installation 
The installation of HELiOS 2016 can be carried out by a technician of the ISD or by the customer. In this 
context, please note the following recommendations by the ISD: 

» HELiOS 

 Update from HELiOS 2014 or 2015 to HELiOS 2016: An installation by the ISD is recommended. 

 Update from HELiOS 2013 (or older) to HELiOS 2016: Updates are not possible. The update 
installation from HELiOS 2008 (or older) additionally includes a data conversion from ANSI to 
UNICODE format. Please contact the ISD Consulting team.  

» 3rd party CAD with HELiOS 

 Update of HELiOS 2014 or 2015 to HELiOS 2016: An installation by the ISD is recommended. 
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5 License Installation Guide  
HELiOS can be activated via three license types:  

» Network licenses 

» Standalone licenses (local licenses) 

» Commuter licenses 

 

 To start the Online Help for the Licence Manager call the LICENSEMANAGER.HTML file in the folder 
Docu\tools\Licensemanager.  

 

5.1 General Information about Licensing 
Local (Workstation-Specific) Licensing 

If you choose local licensing, the activation will be directly locked to the hardware of the workstation on 
which your HELiOS program is installed.  

The ISD will send you an E-mail containing the Entitlement ID for local licenses (standalone).  This ID will be 
required for the activation and deactivation of the licenses and software modules. Please keep the 
Entitlement ID! Without this ID you cannot activate or deactivate any licenses! In case of a defect, no 
reconstruction of licenses will be possible without the Entitlement ID!  After installing HELiOS, you activate 
the licenses by means of the License Activator in the ISD License Manager. 

 

Network (Server-Controlled) Licensing 

If you choose network (server-controlled) licensing, the license will be directly locked to the hardware of the 
server that centrally manages the HELiOS licenses. These licenses can be used on any workstation in your 
network that is connected to this server.  

The ISD will send you an E-mail containing the Entitlement ID. If you have several network servers, e.g. at 
several locations, you will receive one Entitlement ID for each network server. This ID will be required for the 
activation and deactivation of the licenses and software modules. Please keep the Entitlement ID! Without 
this ID you cannot activate or deactivate any licenses! In case of a defect, no reconstruction of licenses will 
be possible without the Entitlement ID!  You activate/deactivate the network licenses by means of the 
License Activator in the ISD License Manager.  

Individual licenses can be checked out from the server and locked to a workstation within or outside the 
network (so-called “commuter licenses”). This enables you to continue working at a different location, 
without being connected to the license server (unless your HELiOS installation requires a connection to a 
database server).  For this purpose you define a specific period during which you want the license to be 
available on a selected workstation. For this period, this license will be blocked on the license server. After 
expiry of this period, the license will be made available on the license server again. It is also possible to 
manually return this license to the server before expiry of the defined period, if the workstation is connected 
to the server. Licenses for one workstation can be checked out for at least one day, with the counting 
beginning at 1:00 AM on the day following the checkout date.   

If you want to replace/exchange your license server, you need to deactivate all licenses first. 

 

 A static IP address is required for correct operation of the license server! 
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Practical Examples of Network Licensing 

» Let us assume that three licenses have been activated on your server. Monday morning (11.00 am) you 
suddenly need to see a customer for design tasks, and you know that you will still be on-site at the 
customer’s facility on Tuesday. You therefore check out a license for 24 hours on 11.00 am. This 
means that you can use this license until Tuesday night, 11.59 pm, from your mobile workplace. After 
expiration of this period, the license is automatically made available again on the server. If you manage 
to finish your work on Tuesday at midday, you can go back to your office and return the license to the 
server somewhat earlier. 

» Similar situation as the one described above, with the difference that you are not in your office on 
Monday, 11.00 am. In such cases you can generate a hardware ID, enabling your colleagues in the 
office to check out a license for you. This license is sent to you by E-mail and can then be activated. In 
contrast to the previous example, this license is exclusively available to you for a fixed period of time and 
cannot be returned to the server before expiration of this period. 

 

 If you activate a license while the WLAN card is switched on, this license will only be valid and visible when 
the WLAN card is switched on. If, however, the license is activated while the WLAN card is switched off, the 
license will always be valid, no matter whether the WLAN card is switched on or off.  
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5.2 Network Licenses 
To be able to use network licenses, a License Server needs to be installed on a computer without HELiOS.  

The license server enforces and manages licensing in multi-user environment. It keeps track of all the 
licenses and handles requests from network users who want to run a HELiOS application, granting 
authorization to the requesters, or denying requests if all licenses are in use.  

The license server must not be installed on the same computer on which an ISD software product 
(HiCAD/HELiOS) is installed, as both product share system data concerning the licensing information. 
Formerly, such parallel installations of license servers and ISD products were performed in cases where a 
customer occasionally wanted to transfer the license to another computer (Remote Commuter License).  

 

 Please note:   

 As of HiCAD 2012 (Version 1700), parallel installations of license servers and ISD products (i.e. on the 
same computer) are no longer covered by the warranty. The ISD group advises you strongly not to 
perform such installations. 

 A static IP address is required for a correct operation of the License Server! 
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5.2.1 Server Installation 
The installation of the SafeNet License Server takes place from the HELiOS DVD. Start Windows and insert 
the DVD in the DVD drive of your computer. The installation wizard will be displayed.  

 

 If you want to perform a HELiOS update to Version 2016 and use a license server (i.e. work with network 
licenses), you require Version 8.5.0.1400 of the SafeNet License Server. If you have installed an older version, 
you need to uninstall it before re-installing the SafeNet License Server. 

 

 

Click the the SafeNet License Server button. 
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License Installation Guide 

 

 56 UNLIMITED PERFORMANCE 
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After successful installation you will find the Server (Sentinel RMS License Manager) under Services. From 
here you can also start and end the License Server.  
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5.2.2 Client Configuration 
To ensure that the HELiOS Client finds the correct License Server, an environment variable LSFORCEHOST 
should be set on each Client using network licenses. The value HOSTNAME, respectively the IP address of 
the License Server is assigned to the variable. 
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5.3 Licensing via Entitlement ID (License Activator) 
Thanks to the enhanced ISD License Manager 2.0 the communication between the customer and the ISD 
could be facilitated significantly.  

 

5.3.1 AutoRequest Licenses  
When acquiring a HELiOS license, you will obtain one Entitlement ID for local licenses (Standalone) and 
another one for network licenses (Network). If you have several network servers, e.g. at different locations, 
you will obtain one Entitlement ID for each network server. These numbers will be required for the activation 
and deactivation of the licenses and the software modules.   

 

 Please keep the Entitlement ID! Without this number you cannot activate or deactivate licenses. In case of 
a system crash a reconstruction of the licenses cannot take place without the Entitlement ID! 

 

After installing HiCAD/HELiOS you can find the program in the Windows Start menu at ISD Software und 
Systeme > Administration. Please note that for the execution of some functions, administrator rights are 
required.  

The range of functions of the ISD License Manager depends on the activation of the License Administration 
Tools option. The information about this setting is entered in the Registry and can also be changed there 
subsequently if desired (please contact the Hotline).   

 

 To activate/deactivate Network Licenses, always start the ISD License Manager via the Windows Start 
menu: Select Start > All programs > ISD Software und Systeme GmbH > Administration. To avoid errors when 
activating/deactivating licenses, perform an update of the new ISD License Manager and/or the License 
Administration Tools beforehand. 
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Activate the License Activator tab and enter the Entitlement ID, your E-mail address and your Password. 
New customers obtain their password from the ISD Hotline. With this password you can also access the 
Download Area.  

 

After entering the data, click Login. The ISD License Manager 2.0 connects to the ISD License Server and 
the acquired licenses will be displayed.  

This process may take several minutes. You can then activate the licenses. 

 

5.3.2 Activate Licenses 
After successful login, the number of available licenses and the number of acquired licenses are indicated 
next to each module. Select the modules to be activated and click Activate to start the activation. For Server 
Licenses the modules are already pre-selected! 

 

After successful activation a message showing you that all licenses have been successfully activated will be 
displayed:  
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You can then log out and start working with the HELiOS modules. 

For Network Licenses, all modules will always be activated or deactivated (for further information about the 
operation of the License Manager, please read the Online Help for the License Manager. 

In addition, you will receive an E-mail informing you about the activated modules.  

 

5.3.3 Deactivate Licenses  
A deactivation of licenses for modules will be required in the following situations:  

» Exchange of hardware or changing of hard disk partitioning 

» Update of the operating system (e.g. from Windows 7 to Windows 10)   
For updates within one version no deactivation will be required. 

» Transfer of local modules from one workstation to another 

» Acquisition of further modules, or return of hired licenses 

» Switch from local licenses to network licenses 

Please note the following: All workstations with modules having the same Entitlement ID need to be 
deactivated completely before a redistribution of the module licenses can take place. 

If you want to deactivate local licenses, or when you log on to the License Manager, please close all HELiOS 
applications beforehand. 

After starting the ISD License Manager the activated modules will be highlighted in a different colour. Click 
the Deactivate button to revoke the activation of the modules.   

 

A selection is not possible, as you need to deactivate all modules, no matter whether local licenses or 
network licenses.  
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 The deactivation must not be disrupted, e.g. by a logout or the closing of ISD License Manager! 

 

After successful deactivation the following message will be displayed:  

 

 

5.3.4 Trial Licenses  
If you select Display trial licenses after logging in, you will be also shown, besides all trial licenses with a 
limited period of validity, all purchasable licenses which are not simultaneously available as trail licenses.  

 

5.3.5 Reconstruction of Licenses  
As all licenses are stored on the ISD Server, you can, in case of an interrupted connection or an accidental 
deletion of licenses, restore all licenses by logging in with your Entitlement ID. The restoring will only function 
if the hardware was not changed (see 4.2.3.3 Deactivate Licenses). 

 

5.3.6 Notes Regarding the Use of Mobile Computers (Laptops) 
If you use a computer with WLAN card, Please make sure that the WLAN card will be either always switched 
on, or always switched off. 
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5.4 Commuter Licenses 
Commuter licenses enable you to use network licenses even if the workstation is not connected to the 
Server. There are two ways of receiving commuter licenses: 

» Via direct checkout from the License Server 

» Via checkout from License Server, without network connection 

 

5.4.1 Direct Checkout from License Server 
Start the ISD License Manager application (while a connection to the Server still exists). Switch to the 
Commuter License tab.  

 

If you have set the system environment variable LSFORCEHOST, the entered License Server will be 
displayed as the preselected server upon start. Use the Search network button to automatically search for 
License Servers.  

Expand the tree structure of the found Server by a click on the “+”-sign. The result looks as follows:  

 

Select the required licenses by activating the corresponding checkboxes on the left hand side. On the right 
hand side, information on the selected license is displayed.  
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In the Commuter license: Validity in days field, you enter the number of days that you want the commuter 
licenses to remain checked out from the Server. The maximum number of days is 60. By default (or if a “0” 
is entered), the value is set to 1.  

 

 For reasons of safety you should check out the licenses only for the required period! If a commuter 
license is lost, e.g. because of theft or a defect of the client computer, the license on the Server cannot be used 
any more before expiry of this date! 

 

 

After entering the expiry date for the commuter licenses, activate the Update licenses button. 

 

Commuter licenses are checked out from the Server. 
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All selected licenses are now checked out from the Server and you possess all rights on your computer for 
the specified validity period for the commuter licenses. This means that you are enabled to work network-
independent. The checked out licenses are no longer available to the other computers on the net.  

You can however also return the commuter licenses before their expiry date. To do this, you need to connect 
to the Server, deactivate the checkboxes on the left hand side and click the Update licenses button. All 
licenses are now made available on the Server and locked on your computer, i.e. you can now only use 
HELiOS if there is a connection to the License Server. The licenses made available again can now also be 
used from other workstations. 

 

 

5.4.2 Checkout from License Server, Without Network Connection 
Commuter licenses can also be drawn from the License Server without an existing network connection.  

 

 Please note that administrator rights are required.  

Commuter licenses checked out in this way cannot be returned to the License Server! This means that the 
commuter licenses that have been checked out from the Server are only (automatically) made available again 
after their expiry date. 
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Several steps are required for this, by the administrator having a network connection to the License Server, 
as well as by the Client having no network connection to the License Server.  

The Client starts the ISD License Manager tool, switches to the Remote Locking Code tab and sends the 
generated character set to the administrator (via E-mail or over the phone). 

 

 

The administrator starts the ISD License Manager and switches to the Commuter License tab. The License 
Server is selected, and the required licenses (modules) are activated in the left window. To checkout a 
remote commuter license the administrator now needs to activate the Check out authorisation for remote 
computer checkbox. 

 

A click on the Update licenses button opens a new dialogue window, in which the administrator enters the 
character set received from the Client.  
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After selecting OK, another dialogue opens, in which you enter the target path and the file name for the 
licenses to be swapped out.  

 

Click OK to check out the commuter licenses from the License Server and swap them out to a file, e.g. 
RemoteLicCode.lic. 

 



License Installation Guide 

 

 68 UNLIMITED PERFORMANCE 

The successful checkout will be confirmed. The administrator then sends the file RemoteLicCode.lic to the 
Client.   

After receiving the file with the commuter licenses, the Client starts the ISD License Manager again and 
activates the Install Remote Authorisation Code tab. Here the received commuter licenses can be installed 
directly via file selection or via copying of the file contents.  

 

Click the Install... button to install the commuter licenses on the Client.  

After successful installation, switch to the License Info tab. Press the F5 (Update) key on your keyboard. 
You are now informed which licenses are installed locally on the computer.  
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5.5 License Configuration HELiOS 
Some cases may require the use of only certain specific licences on a computer. Example: On the License 
Server, HELiOS and Plot Manager licences are available. On one Client, HELiOS is to be started, on another 
Client, the HELiOS Plotmanager. If the selected license is no longer available, an application start is no 
longer possible.  

 

 If there are several basic modules in a standalone (workstation) license (to which also the Commuter 
Licenses belong), it is mandatory to make a pre-configuration and save it as workstation configuration. If no 
pre-configuration is possible, the HiCAD/HELiOS configuration tab will be displayed before the start of 
HiCAD/HELiOS. If the selected configuration does not match the available licenses, a warning message will be 
issued, with a list of available licenses. After this, the configuration selection will be displayed again. 

 

 

On the HELiOS Configuration tab of the ISD License Manager tool you have the option to save a workstation 
or user configuration for individual Clients.  

» Save as workstation configuration: This configuration will be saved for all users of this computer. When 
HELiOS is started, the selection window is no longer displayed (administrator rights are required for 
this).  

» Save as user configuration: This configuration is only saved for the current user. When HELiOS is 
started, the selection window with the saved configuration is always displayed.  

These licence configurations apply to network licenses and standalone (workstation) licenses.  

 



License Installation Guide 

 

 70 UNLIMITED PERFORMANCE 

5.6 Important Softlock/Hardlock Information 
When using the softlock/hardlocks as selector for the license file, please note that for system-inherent 
reasons the date must not be reset! Such resetting causes a blocking of the softlock/hardlock that can only 
be revoked by the ISD by means of a re-programming. In such cases, we would have to charge you the 
costs of this unnecessary additional work. 

A change of the system time is possible, as long as it is not date-comprehensive. 

If you deem such date conversion absolutely necessary, please inform our staff on the hotline in good time. 

 

ISD Software und Systeme GmbH 

Phone: 0049 - 231 / 97 93 - 166 

Fax: 0049 - 231 / 97 93 - 101 

Mailto: hotline@isdgroup.com 

 

 IMPORTANT:  If you have a 64Bit version of HELiOS, the hardlock can no longer be used as license file 
selector due to missing driver support! 

 

mailto:hotline@isdgroup.com
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5.7 Theft of a Workstation 
The user is responsible for appropriately insuring the HELiOS workstations against theft. If desired, we can 
tell you the reinstatement value of your software. If a workstation is stolen, you will need a new license. In 
such cases, please send us the police report of the theft first. We will then provide you with a license for a 
limited period of time, and submit an offer for a new license to you. The ISD will send you the new license 
after clarification of the case with your insurance and receipt of your payment for the license fee. 
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6 HELiOS at a Glance 
On the way to the finished product, time expenditure, the cost situation and product quality can only be 
optimised if all departments of a company work together efficiently. This requires a well-structured and 
efficient exchange of information between the parties involved in the production process - from 
Manufacturing, Purchasing and Service to Marketing and Sales. 

HELiOS is a state-of-the-art PDM/PLM system providing all essential tools for an error-free logging, 
management and distribution of the data required for the production process chain. Once saved, these data 
can be re-used within the entire company and for the complete product life cycle. HELiOS manages and 
controls all process cycles by regulating and monitoring the processing and transfer of these data. 

Thus, the know-how of the company will be used optimally, redundant work can be avoided and error 
sources will be eliminated. 

HELiOS combines Product, Process and Peripherals Management to form a single system, thus making 
HELiOS the “knowledge reservoir” of your company. 

HELiOS can be integrated in your overall CAD system or used as a stand-alone system, the so-called 
HELiOS Desktop 

Thanks to its modular structure, HELiOS can be optimally adapted to company-specific requirements.  
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7 First Steps 
7.1 Program Call 
Start the HELiOS Desktop by double-clicking on the HELiOS.EXE file in the \HELiOS\exe directory or via the 

program icon  on your Desktop. 

Default setting is the project-independent start. Please note that the list view in the right-hand window will 
not be shown when you start HELiOS Desktop for the first time. Select a project first and display the list view 
via View and then Lists. 

If you have not ended HELiOS correctly during your last session, you will receive an error message from the 
Vault Server. 

 

  Important:  

Improvements of the HELiOS functionality require a regular updating of the database; if the database version is 
no longer up to date, HELiOS displays a corresponding message (version numbers may vary) when it is launched. 
In this case, please read the information in Chapter "Updating the HELiOS Database". 
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7.2 Registration 
The HELiOS User Management is based on the User Management of Windows. If several users are 
registered with the same Windows User Name in EDBSETUP, a login mask will appear when starting 
HELiOS Desktop.  

Name and active group enable the user to login with the rights guaranteed by the User Management.  

If you select a project from the Active Project drop-down list, this project will be opened after starting 
HELiOS Desktop. If you select the project-independent setting, all documents will be displayed. 

Start the HELiOS Desktop with Login (see below).  

To ensure that a specific project will be opened after starting HELiOS Desktop, you need to specify a Start 
Project. On the Ribbon, activate the Tools tab, then select Options, activate in the dialogue the General tab 
and choose a start project.  

 

7.2.1 Login 

Use the Login  function for a new login while working with HELiOS Desktop, e.g. to work with different 
rights without having to exit the program.  

Activate the Login  function on the QuickAccess toolbar.  

Select a different user.  

Change the active project if required and confirm the new settings with Login. 

 

7.3 The News window 
In order that you can take full advantage of the numerous new features and enhancements offered by 
HELiOS 2016, check out the videos explaining the new and changed HELiOS functionalities. From now on 
we will provide you with such videos with each Major Release and Service Pack to keep you constantly 
informed in the best possible way.  

You can configure the display of the News window at the bottom left. Please note that you can configure the 
display of the News window at the bottom left. We recommend using the Show most recent news option to 
ensure that you will never miss any news about HELiOS. If you selected the Show never option, you can call 
the News window again at any time and change the display option by clicking on the “?” symbol at the top 
right and selecting Show news. 

 

 

mk:@MSITStore:D:%5CDokumente%20und%20Einstellungen%5Csduempelmann.INT%5CDesktop%5Chelios.chm::/AllgemeinesZuHeliosNext/Konfiguration_(EDBSETUP)/HELiOSKonfiguration.htm
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8 How to Use the Help 
The Online Help provides you with information, descriptions and examples on all functions and techniques 
which are available in HELiOS.  

 

 Please note that the scope of available functions may vary, depending on the configuration level of your 
HELiOS product. This means that some of the functions described in the Online Help may not be available in your 
system. 

 

The Help will be available both locally (status of the installation DVD) and on the Internet (regularly updated) 
at help.isdgroup.com. Both versions of the Help can be called from HELiOS. In the HELiOS Options window, 
open the Help tab and select Online or Local.   

 

 

To call the Help, click the “?” symbol at the top right of the window and choose HELiOS Desktop Help.  
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To be able to use the Internet version of the Help, you need to register for the ISD’s new company Wiki 
once. This will not only give you access to the new Help, but also provide you with many other information 
that is available in the ISD Wiki (Forum, Download area etc.). 

Click Sign up in the login window of the Online Help to register. If you have already been registered, enter 
your access data and click Login to get directly to the start page of the Online Help.  
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8.1 Register for the ISD Wiki 
After clicking Sign up in the Login window of the Online Help, enter the data required for the ISD Wiki in the 
dialogue window. Confirm the security prompt and click the Sign up button. 

 

After the registration the dashboard of the ISD Wiki will be displayed. A message indicates whether you have 
been authenticated as an ISD customer.  

If you could be identified as an ISD customer, you can now directly launch the Online Help using your 
registration data.  

If you could not be identified as an ISD customer, please perform the steps described in the message.  
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9 What’s New in HELiOS 2016? 
A detailed overview of all new features and enhancements contained in Version 2016 can be found in the 
What’s New? topic of the Online Help.  

Alternatively, you can click the  button in the Help.  

Clicking the  button opens an overview of the new features in PDF format in the in the download 
area of the ISD Wiki.  
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